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Description 

Most building design projects live in 2 worlds: everything inside the building, and everything 
outside the building. The 2 worlds only come together after an excessive amount of swearing 
and hours of unnecessary time spent. But does it have to be that way? Absolutely not. 
Coordinating Revit software and Civil 3D software, even in the cloud, doesn't have to require a 
degree in theoretical physics, and this session is where you can learn how. Co-presented by a 
Revit and a Civil 3D specialist, this session will provide an understanding of the expectations for 
each platform and learn how to configure them. With coordinated model locations in place, we'll 
define effective practices for exchanging data between Revit software and Civil 3D software 
through BIM 360. Finally, using the full potential of each coordinated design model, you will 
learn how to assemble your project in the context of its surroundings using InfraWorks software. 
 

Learning Objectives 

• Learn how to establish shared coordinates between Revit and Civil 3D  

• Learn how to share a Surface model from Civil 3D with Revit using BIM 360 

• Learn how to incorporate Revit building model data in Civil 3D 

• Learn how to assemble design-model data into an immersive InfraWorks model] 
 



 

 

Page 2 

Speakers 

 
 
Nick Sipes has over a decade working in the design and construction industry. For seven years, 
he worked for a major global Architecture firm in their interior design group where he specialized 
in corporate offices and government facilities. Following his efforts there, he transitioned to a 
small Maryland Architecture firm where he became their BIM champion by working to migrate 
them from AutoCAD to Revit. For the last 3 1/2 years Nick has been an Applications Specialist 
at CADD Microsystems focusing on BIM related workflows using Revit, Dynamo and BIM 360. 
He has presented at several Revit User Groups on the East Coast and the Director of the BIMxt 
Network, a live online grouping discussing all things BIM in the industry. 
 

 
 
Marissa Gagné is the Practice Manager for Civil and Infrastructure at CADD Microsystems. 
Marissa graduated from Virginia Tech with Bachelor's and Master's degrees in Civil 
Engineering. She has been working with Autodesk products for over 25 years, specializing in 
the Civil and GIS solutions. She has worked for a number of reputable civil firms in Virginia 
providing CAD support to transportation, utility, land development, mapping, and GIS projects. 
At CADD Microsystems, Marissa's responsibilities include managing the Civil Team, performing 
product demonstrations, teaching classes, giving seminars and workshops, and performing 
consulting for many Autodesk products such as Civil 3D, Land Desktop, Map 3D, and Raster 
Design.
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Overview  

Some people may say that Architects and Civil Engineers are from two different planets. And 
they’re kind of right! For this reason, getting along can be hard sometimes. Especially when you 
live and work in two different worlds – or two different coordinate systems, at least. But guess 
what! All it takes is a little bit of understanding, some cooperation, and some good software to 
help us all play nicely together in the sandbox of design. 

 
How is this possible, you say?  Well, all it takes are 6 simple steps: 
 

• Step 1:  Acceptance – Work together to agree on a coordinate system to use 

• Step 2:  Initial Handoff – Locate Points in Revit and provide an export of a building shell 
for use in Civil 3D 

• Step 3:  Establishing Coordinates – Set real-world coordinate system and establish 
building corner coordinates and rotation in Civil 3D. 

• Step 4:  Revit Learns Coordinates – Set real-world coordinates, building location, and 
rotation provided by Civil 3D in Revit. 

• Step 5:  Synchronizing the Design Models – Share the building model for use in Civil 3D 
and the Surface model for use in Revit 

• Step 6:  Visualizing in Infraworks – Display the Surface and the building model in 
Infraworks to create realistic visualizations of the site. 

 
In this document, we will discuss these steps and the software involved in each one. By the end 
of this handout, you will understand how coordinates work in Civil 3D and Revit as well as know 
how a model can be shared between 3 different software platforms and always fall in the correct 
location.    
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FIGURE 1: BUILDING AND SITE VISUALIZATION IN INFRAWORKS 

Software Overview 
This class presents a collaborative workflow between both building Architects and Engineers 
with Civil Engineers. To accomplish this workflow we need the following Autodesk software: 
 

• Civil 3D 

• Autodesk Revit 

• Autodesk InfraWorks 

• Autodesk Navisworks Manage1 
 

Additionally, you will need access to the BIM 360 Document Management module to gain 
access to the files stored in the BIM 360 project. In order to access the files stored in BIM 360 
Document Management on your local computer, you will need to install the Autodesk Desktop 
Connector. It can be downloaded free from the Desktop Connector page of the Autodesk 
Knowledge Network.  
 
In order to have the ability to export Naviswork files (NWC) from Revit, you either need the free 
Navisworks NWC Export Utility or Navisworks Manage installed. Both of these pieces of 
software have product years/versions that need to match the Revit product year/version being 
used. The free Navisworks NWC Export Utility can be downloaded from the Navisworks NWC 
Export Utility page on Autodesk’s website. 
 
There are a number of options for bringing the building model into Infraworks. First, the Revit file 
itself can be directly inserted. However, this insertion can be time consuming and requires you 
to manually specify a location and rotation for the building inside of the Infraworks model. An 
alternative, more efficient way requires the use of Naviswork Manage. With Navisworks 
Manage, an FBX file can be created from the Revit file that includes the proper coordinate 
system, location, and rotation.  
 

 

1 This is only required in order to create an FBX file that can be inserted into InfraWorks. If you do not 
have Navisworks you can link in the Revit file, but this will take a lot longer, and the location will need to 
be specified. 

NOTE: Although BIM 360 Document Management is 
referenced throughout the presentation, it is only 
required in order to link the topography from Civil 3D 
to Revit. The rest of the workflow, including having 
Revit gather the coordinates from the Civil 3D DWG, 
can be achieved without the use of BIM 360. 

https://knowledge.autodesk.com/support/desktop-connector/learn-explore/caas/CloudHelp/cloudhelp/ENU/CONNECT/files/CONNECT-Install-and-Update-Desktop-html-html.html
https://www.autodesk.com/products/navisworks/3d-viewers?plc=NAVSIM&term=1-YEAR&support=ADVANCED&quantity=1#internal-link-navisworks-nwc-export-utility
https://www.autodesk.com/products/navisworks/3d-viewers?plc=NAVSIM&term=1-YEAR&support=ADVANCED&quantity=1#internal-link-navisworks-nwc-export-utility
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Step 1:  Acceptance 

Let’s face it. Civil Engineers and Architects are often very different types of people. So, the first 
step to getting along is understanding and acceptance of each other and the design and 
documentation needs of one another. 
 

Dear Civil Engineers, 
Architects’ building drawings are rotated so that they fit nicely on a sheet of paper for the 
creation of construction documents. While engineers often use view adjustments to rotate their 
sites for the same purpose, the difference is that the Architects don’t really (need to) know the 
direction of North in relation to their building for their documentation purposes. And that’s ok. 
Also, their drawings are used for the construction of the building itself. It’s really the Surveyor’s 
job to make sure it’s built in the right place. 
 

Dear Architects, 
The world is round, and it revolves around the sun, not around your building! I know it’s hard to 
believe, but it’s true. Your building will be virtually useless if you have no roads, utilities, paths, 
drainage or other infrastructure around it. This is where the Civil Engineers come in. They need 
to make sure all of this ties together. And not just with your building but with all of the other 
buildings and other fun stuff around it. For this reason, the Civil Engineers need to be able to 
know where your building is in relation to all of this infrastructure around it. Hence their need to 
locate your building and their designs in real-world coordinates. 
 

Locating Buildings in the Real World 
Buildings, bridges, roads, pipes, and other infrastructure items are all located in real-world 
coordinates based on a system of flat grids. These grids come in many forms. One of the more 
popular sets of grids used in the U.S. are called “State Planes”. As shown in the map below, the 
country is broken down by state, with many states having more than one State Plane Zone: 

 
FIGURE 2: ILLUSTRATION OF U.S STATE PLANE COORDINATE ZONES 
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Why is this necessary? 
Picture this:  You have a basketball in one hand and an 8 ½” X 11” piece of paper in the other. 
The basketball represents our spherical planet and the paper represents a flat set of X,Y 
coordinates.   

 
 

Can you make that piece of paper fit smoothly on that basketball? The answer is no. Even if you 
tried to cut it, parts of the paper would still be crinkled while others would overlap. The curvature 
of our Earth means that having one, flat, X/Y coordinate system will not allow for the accurate 
mapping of our designs. While Latitude and Longitude values can be used all over the planet, 
these are angular measurements are difficult to translate quickly into the units we typically use 
in design for length (meters, feet, etc.). For this reason, the world is broken up into separate 
grids with unique origins that allow us to map our designs to a curved earth as closely as 
possible. An illustration of this concept is shown below.  The green box shows an example of a 
small area that has been mapped to a relatively flat square and uses X,Y coordinates. 

 
FIGURE 3: MAPPING A FLAT PLANE TO A SPHERICAL OBJECT 

Civil 3D and Coordinate Systems 
Civil 3D supports over 800 different coordinate zones and projections that cover the world.  
Based on the location of the project, Surveyors and Civil Engineers often agree on a coordinate 
system that will be used. These coordinates are used for Survey data collection in the field, site 
layout, utility placement, construction stakeout, and more. For this reason, when a Civil 3D 
drawing is created, it is often assigned a coordinate system. This does not change the 
coordinates of objects that are already in the drawing. It tells the drawing which coordinate 
system is represented by the drawing coordinates to allow for coordinate conversion if/when 
necessary. 

http://www.pngall.com/basketball-png
https://creativecommons.org/licenses/by-nc/3.0/
https://creativecommons.org/licenses/by-nc/3.0/
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Revit and Coordinate Systems 
Revit has 3 coordinate systems: Internal Coordinates, Project Coordinates, and Shared 
Coordinates. The Internal Coordinate system was not explained in the presentation for the sake 
of time but is described below. 

Internal Coordinates 
This coordinate system is the internal mathematical coordinate system Revit uses to 
locate all objects within the computer model. This coordinate system has the origin at the 
point known as the Internal Origin which can be revealed in versions after Revit 2020.2. 
This coordinate system can cause graphic issues as elements get further away from the 
origin. 

Project Coordinates 
Project Coordinates are aligned so that the Y-axis in plan is oriented to Building or Plan 
North. This coordinate system has the origin at the Project Basepoint and is used to 
locate elements relative to the building model. This coordinate system will always have 
the X and Y axis in the same direction as the Internal Coordinate System. It is best 
practice to keep this system aligned to the Internal Coordinate system. In other words, 
keep the Project Base Point and the Internal Origin in the same place! Keeping this 
system aligned with the Internal Coordinate System will insure graphic fidelity. This is 
shown as an orange grid in Figure 4 below. 

Shared Coordinates 
Shared coordinates are used to locate the building in the real world. This system is 
sometimes referred to as Survey Coordinates, GIS Coordinates, Grid Coordinates, or 
State Planes. There is no visible origin point for this coordinate system in Revit, which is 
good due to the graphic fidelity issues associated with distances from the Internal Origin. 
This coordinate system is established by specifying a relationship between this 
coordinate system and the Project Coordinate System. The process of specifying the 
location of this system is covered in this class. This is shown as a blue grid in Figure 4 
below. Because this system is located by specifying a relationship between the Project 
Coordinate System and the Shared Coordinate, it allows the Revit model to exist in 
multiple Shared Coordinate Systems or multiple locations within the same coordinate 
system.  
 

Revit Reference Point 
Revit has 3 reference points that have been sometimes noted as “Origins”. This is not 
exactly true.  
 

•  Internal origin – This is the 0,0,0 of the Internal Coordinate System and was 
given its own visual point in Revit in release 2020.2. This is the point that can 
cause the 30-mile radius issues.  

•  Project Base point – This is the origin of the Project Coordinates. This 
should be located at the Internal Origin and NEVER moved! This is also the point 
that stores the relationship between the Project Coordinates and the Shared 
Coordinates. 
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•  Survey Point – There is a misconception that this is an origin point. It’s not! It 
is a reference point; it is used to note the location of an existing known point in 
the real world. It has no control over any coordinate system. It does not represent 
the origin point of the shared coordinates, and it does not control the elevation of 
levels (even though Revit’s interface says it does). 

 
FIGURE 4: REVIT COORDINATE SYSTEM – VIEW ORIENTED TO TRUE NORTH. 
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Step 2:  Initial Handoff [Revit] 

Before Revit can coordinate with Civil, or even other Revit Models, there are a few things that 
need to be determined. The first thing we need to determine is where the building’s datum will 
be located. In other words, if it is new construction, where is the point that the contractor is 
going to use to start laying out the structural grid? That might require a conversation with your 
Structural Engineer. Once selected, this point will act as the origin of the Project Coordinates. In 
other words, it will locate the Revit Project Base Point, and in turn, the Internal Origin at this 
point. 
 

Initial Revit File Setup 
Follow these steps to reveal the 3-reference points to make sure your building’s datum is 
located at the Project Base Point and Internal Origin. 
 

1. Open a first floor or site plan view from the “Project Browser”. 
 

2. Choose “Visibility/Graphics” from the “Graphics” panel of the “View” Ribbon tab. The 
“Visibility/Graphic Overrides for <view name>” dialog box opens. 

 
FIGURE 5: VISIBILITY / GRAPHICS BUTTON 

3. Scroll to the “Site” visibility node of the list and click [+] to expand the visibility. The sub 
list of site categories displays. If you are in a version of Revit after 2020.2, “Internal 
Origin” will be listed. 
 

4. Check the Visibility checkboxes for “Internal Origin”, “Project Base Point”, and “Survey 
Point” from the list of site elements. Click “OK” to apply the updated visibility and return 
to your model view. 

 
FIGURE 6: REVIT SITE REFERENCE POINTS 
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Alright, so now we’ve established the Project coordinates and Project North (Plan North), and 
we’ve revealed the reference points. At this point, we can start drawing the building, making 
sure to locate the datum at the Project Base Point. After we get the building outline drawn, we 
can start the process of coordinating with Civil and the outside world.  
 
Alright Architects, it’s time for another one of those acceptance moments. We cannot locate the 
building in the real world without a Civil Engineer. We may think we know where the building 
goes, but we don’t always consider site drainage, grade, and infrastructure. So, we might 
“locate” the building on the site close to where we want. But we need a Civil Engineer to tell us 
the actual location. For them to provide us a location of the building, we need to provide them 
with a plan of the exterior of the building, and if it is new construction, the structural grid.  
 

Export Civil Export Plan View 
Follow these steps to export the building footprint from Revit: 
 

1. Create a new floor plan to generate a “Civil Export Plan View”. Don’t duplicate 
this from an existing view. 

2. From the “Create” panel of the “View” Ribbon tab, choose “Plan Views” ➔ “Floor 
Plan”. The “New Floor Plan” dialog box opens. 

 
FIGURE 7: CREATE FLOOR PLAN VIEW(S) 
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3. If your company has a view type for Coordination Plans, select it, otherwise use a 
standard floor plan. Choose the appropriate level. You may need to uncheck “Do 
not duplicate existing views”.  

 
FIGURE 8: NEW FLOOR PLAN 

4. Right-click the newly created view within the Project Browser and select 
“Rename” from the contextual menu. Enter EXPORT – CIVIL PLAN. To help 
reduce confusion, change the view “Discipline” to “Coordination”. You may also 
want to move it to a “Coordination” section in your Project Browser.  

 
FIGURE 9: NAMED VIEW 

5. In the Properties of the view, change the property Orientation to True North. 

 
FIGURE 10: VIEW ORIENTATION PROPERTY 
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6. Open the “Visibility/Graphics” dialog box from the Ribbon (see Figure 5), or by 
entering VV on your keyboard. The “Visibility/Graphic” dialog box opens allowing 
you to turn off the elements you do not want to see. 

 
FIGURE 11: VISIBILITY GRAPHICS DIALOG 

7. Click the “All” button at the bottom of the “Visibility/Graphic” dialog box to select 
all rows. Uncheck the visibility of all modeled objects. Click “None” to unselect all 
rows. 

8. Select the checkboxes next to “Walls” and “Doors” and the 3 reference Points 
(Internal Origin, Project Base Point, and Survey Point) found as sub categories 
under “Site”. The visibility of all modeled objects except for walls, doors, grid 
lines, and the 3 reference points should be turned off. Click “OK”.  

9. From the “View” Ribbon tab, choose “Filters” from the “Graphics” Panel to begin 
creating a filter to hide the interior walls and doors; displaying only the exterior 
walls and doors for your project. The “Filters” dialog box opens. 

 
FIGURE 12: VIEW FILTERS LAUNCH 
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10. Choose the “New” button from the bottom left corner of the “Filters” dialog box, 
as show in Figure 13: New Filter. The “Filter Name” dialog box opens. 

11. Enter a name for your filter, Walls and Doors – Not Exterior in this example, 
select the “Define Rules” radio button, and click “OK” to create the filter. 

 
FIGURE 13: NEW FILTER 

12. Choose “Walls and Doors” from the “Categories” group in the center of the 
“Filters” dialog box. It’s important to note, for this to work correctly, the function 
parameter of each wall type and door type in your model must be appropriately 
designated. 

13. Configure the “Filter Rules” group on the right of the “Filters” dialog so that the 
parameter is set to “Function”, the operator is set to “Does not equal”, and the 
value is set to “Exterior”. Refer to Figure 14 below.  

 
FIGURE 14: RULE SETTINGS 

14. Open the “Visibility/Graphics” dialog box (type VV or VG on the keyboard, or see 
Figure 5) to apply this filter to your view. 
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15. Browse to the “Filters” tab of the “Visibility/Graphic Overrides” dialog box and 
click the “Add” button. The “Add Filters” dialog opens to display a list of available 
filters in the current model. See the Figure 15 below. 

 
FIGURE 15: ADD VIEW FILTER 

16. Select the “Walls and Doors – Not Exterior” filter under the “Rule-Based Filters” 
group within the “Add Filters” dialog box (shown above). Click “OK” to return to 
the “Visibility/Graphic Overrides” dialog box. 
 

17. Uncheck the “Visibility” checkbox for the “Walls and Doors – Not Exterior” filter. 
This makes all walls without a function of “Exterior” not visible. Click “OK”. 

 
FIGURE 16: VIEW FILTER VISIBILITY OVERRIDE 

18. Set the detail level of the view to “Course”. This will make all your walls exterior 
lines only.  
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19. On the “File” menu, choose “Export” ➔ “CAD Formats” ➔ “DWG” to begin the 
process of exporting the current view to an AutoCAD drawing file. The “DWG 
Export” dialog opens. 

 
FIGURE 17: REVIT EXPORT DWG 

20. Verify that the “Export” drop-down is set to  “<current view/sheet only>” and 
match the settings in the Figure below. 

 
FIGURE 18: DWG EXPORT 

21. Next to the “Select Export Setup” drop down, click the builder button, as shown in 
the image above. This will open the “DWG export settings”. Go to the “Units and 
Coordinates” tab. Make sure you select the Units that align with your Civil 
Engineer’s coordinates. At this time, the coordinate system does not matter 
because they are aligned, so they will both export to Project North. Then click 
“OK” to close the “DWG export settings” dialog. 
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22. In the “DWG Export” Dialog click “Next…” to open the “Export CAD Formats – 
Save to Target Folder” dialog. Browse to your BIM 360 project directory and 
select the folder that has been configured for sharing files with the Civil 
Engineers. Specify a name for your DWG file and click “OK”. 

We typically recommend the addition of the words “Project Coordinates” at the 
end of the file name to ensure that everyone knows that this file is aligned to the 
project coordinates and not the Shared Coordinates. 

Now that the export is created, make sure to collaborate with your Civil Engineer. Let them 
know where the file is located and let them know where the building’s datum is located. In our 
example, we used column grid intersection G1. Let them know what you will need to locate the 
building in the Shared Coordinates. 
 
In order to establish coordinates in Revit the following information needs to be provided: 

• Grid Northing of the project datum point 

• Grid Easting of the project datum point 

• Elevation of the project datum point 

• The angle between True North and Project North in degrees, minutes, seconds. 

• A copy of their Civil 3D file with the Drawing Settings configured properly. 
 
In order to link topography, we will need a topo Surface that is published to BIM 360. Let them 
know where you would like the files placed and ask them kindly to put the datum location 
information into a Text file that from which you will be able to copy and paste the necessary 
values. 
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Step 3:  Establishing Coordinates [Civil 3D] 

For the Revit model(s) to be geo-located, we need to geo-locate our Civil file by establishing a 
coordinate system. We also need to provide the Architect with certain information to allow them 
to locate their building in our desired coordinates.  
 
As mentioned above, the following information will need to be provided to the Architect: 

• Grid Northing value of their building’s datum 

• Grid Easting value of their building’s datum 

• Elevation of the floor of the building’s datum 

• Angle between True North and Project North in degrees, minutes, seconds. (or decimal 
degrees) 

• A copy of our Civil 3D drawing file 
 

Configuring Civil Drawing Settings. 
The first thing we need to do is to establish the desired coordinate system in the Drawing 
Settings. 

1. In the “Settings” tab of the Toolspace, right-click on your drawing name and click “Edit 
Drawing Settings”.  

 
FIGURE 19: EDIT DRAWING SETTINGS 

2. On the “Units and Zone” tab, in the “Zone” section, use the “Categories” drop-down to 
choose the desired zone group. In our example we chose “USA, Virginia”.  
 

3. Use the “Available Coordinate Systems” drop-down to select the Coordinate System and 
datum that have been agreed upon with the surveyor. In our example, we picked 
“NAD83 Virginia State Planes, South Zone, US Foot” because our project is near the city 
of Richmond, VA. Click “OK” to close the dialog.  
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FIGURE 20: DRAWING SETTINGS – CONFIGURE 

4. Because the AutoCAD units are not automatically tied to the Civil 3D Drawing Settings, 
you will also want to confirm that the Insertion Units are set to the same units as the 
drawing system. Type UNITS into the command line and hit <Enter>.  
 

5. This will open the “Units” dialog of AutoCAD. Make sure the drop-down under the 
“Insertion Scale” is set to match the units in the Civil 3D Drawing Settings. In our 
example, this needs to be US Survey Feet. 

 
FIGURE 21: DRAWING UNITS 

NOTE: Make a note of the “Selected coordinate 
system code”. Since this same coordinate system will 
be referenced in other software such as Revit and 
InfraWorks, this shortened code may come in handy. 
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Insert the Building Footprint and Establishing a Floor Elevation 

 

1. Use the INSERT command to insert the building footprint DWG file provided by the 
Architect into your Civil 3D site design. The origin point on the building chosen by the 
Architect in their model will be the basepoint that you will use to place the building in 
your site. In our example, this is the location of column G1. 

 
FIGURE 22: INSERT BLOCK FROM LIBRARY 

  

TIP: To maintain a clean Civil 3D drawing, we 
recommend opening the DWG file provided by the 
Architect to ERASE any extraneous or unnecessary 
objects from the file before inserting it into one of your 
design drawings.   

 

TIP: It is also recommended that the Units of the 
Architect’s drawing be set to “US Survey Feet” prior to 
the insertion.  Revit does not have an option for “US 
Survey Feet” so the Architect’s only choice in their file 
is “Feet”. 



 

 

Page 21 

2. Use the MOVE and ROTATE commands to find the best horizontal and vertical position 
for the building on your site. If you have not yet had a conversation with the Architect 
regarding the placement of the building on the site, now would be a good time. Most 
likely they have already thought about where the building should be located. This will 
probably only be a design intent location and not a specific location.  

3. Verify the building footprint is also placed at the desired elevation. 

Getting the Project Location Point 
As mentioned above, there are several pieces of information that the Architects need in order to 
locate their building. Most of this information you can get from creating a simple COGO point. 
Because we are all trying to play nicely together, it would be best to copy the necessary values 
into a Text file and/or an e-mail for their use once the desired location, elevation, and rotation 
are established.  
  

TIP: Apply an Elevation Banding style to your existing 
ground Surface and create ranges using a Range 
Interval at Datum to quickly visualize the necessary 
earthwork for the finished floor elevation you choose. 

 

TIP: After this step, make sure to measure the building 
length and other distances to check that they match 
what the Architect originally sent.  If their drawing was 
not changed to US Survey Feet prior to the insert, a 
unit conversion from Feet to US Survey Feet will 
occur, changing the size of the original building. 
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Follow these to create a COGO point for the Project Location Point Information: 
 

1. On the “Home” tab of the Ribbon, on the “Create Ground Data” Panel, select “Points”. In 
the drop-down, select “Point Creation Tools”. This will open the “Create Points” toolbar.  

 
FIGURE 23: POINT CREATION TOOLS LAUNCH 

2. On the “Create Points” toolbar, click the “Surface” drop-down and select “Random 
Point”.  

 
FIGURE 24: POINT CREATION - RANDOM POINTS ON SURFACE 

3. If you have multiple Surfaces in the drawing, you will need to select the desired Surface 
from which to extract an elevation for your new Point. In our example, we only had the 
existing Surface. Then, click in the drawing at the base point location to place the new 
Point.  In our example, it was the grid intersection G1. If prompted, make sure to enter 
an appropriate description for the Point. In our example, we used “COLUMN”. 
 

4. Once the Point is created, you may want to apply a Point Label to the point that displays 
the information the Architect needs from this point. Select the Point and use the 
Properties Palette to change the Point Label Style Property to a Style that displays the 
Grid Northing, Grid Easting, and Elevation. Refer to Figure 25 below. 
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FIGURE 25: POINT LABEL STYLE CHANGE 

5. Create a new Text file (txt) and save it to the folder in BIM 360 set up for sharing 
documents. In that file copy the following information from the Point. 

a. Grid Northing 
b. Grid Easting 
c. Elevation 

6. In addition to the Point coordinates, the Architect will also need the angle between True 
North and the Architect’s Plan North. Essentially, this is the angle that the building was 
rotated from its initial insertion. If you did not specifically a rotation, you can measure the 
angle by drawing a line towards true north from a line on the building following plan 
north, such as a grid line. Add this measured angle to the previously created Text file in 
Degrees, Minutes, and Seconds (DD˚MM’SS”) 

 
7. Finally, save a copy of your Civil 3D file to the shared folder for the Architects use.  

NOTE: The out-of-the-box Civil 3D templates do not 
come with a Point Label Style that already shows this 
information. You will have to create one if you are 
working in a drawing that was created from one of 
those templates.   

TIP:  The fastest way to copy/paste this information is 
to use Civil 3D’s Item View in the Prospector tab by 
selecting the “Points” category and finding the 
necessary point number and row, or through the “Edit 
Points” Vista by selecting the Point, right-clicking and 
choosing “Edit Points”.     
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Step 4:  Revit Learns Coordinates [REVIT] 

At this point, you should have received a text file from the Civil engineer with the building’s Grid 
Northing, Grid Easting, Elevation, True North to Project North Angle, and their DWG file. All this 
information is required to locate the building.  

Specify Coordinates at Point 
In order to locate the building in the same coordinate system used in the Civil file, we first need 
to specify the location of the project base point at the coordinates provided by the Civil 
Engineer.  
 
Follow these steps to specify the location of the building.  
 

1. Create a coordination 3D view that shows the 3 reference points (Internal Origin, Project 
Base Point, Survey Point) 

a. Delete or rename your current default 3D view. If you are in a non-workshared 
model it will be named “{3D}” if you are in a workshared model, then the view 
name will start with “{3D -”  followed by your username and then a “}”.  
 

b. On the “View” Ribbon tab, on the “Create” Panel, click “3D View. This creates a 
new default 3D view.  

 
FIGURE 26: CREATE 3D VIEW 

c. Rename this view COORDINATION – 3D 
 

d. Change the “Discipline” property of the view to “Coordination”. 
 

e. Change any view sorting parameters as needed to group with the rest of the 
coordination views in the Revit model.  
 

f. Open the “Visibility/Graphics” dialog box (type VV or VG on the keyboard, or see 
Figure 5) 
 

g. Turn on the 3 reference points (Internal Origin, Project Base Point, Survey Point) 
as done in the section “Initial Revit File Setup” above. 
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2. There is a chance that the Civil Engineer will provide the values for Grid Northing, Grid  
Easting, etc. in a unit format that is different than the project units of your model.  For 
example, they may provide the values in decimal feet while you’re model is in Feet and 
Inches. If this is the case, temporarily change the “Project Units” of your model to match 
those units provided by the Civil Engineer.  
 
You might be wondering why this is important; doesn’t the Revit database just store 
those values in decimal feet anyway? Yes, it does. However, if the project units are set 
to feet and fractional inches, and you type decimal feet value, the user interface will 
convert the decimal feet to feet and fractional inches to the closest fraction, which could 
move the point ever so slightly. Now, if your Civil Engineer is working in US Survey Feet, 
you do not need to put your units to US Survey Feet. The Grid values the Civil Engineer 
provided are all you need and understand that they are “Feet”. Wouldn’t it be better if 
everything was metric?  
 

a. On the “Mange” Ribbon tab, on the “Settings, click “Project Units”. 

 
FIGURE 27: PROJECT UNITS 

b. In the “Project Units” dialog, click the button next to “Length” in the “Format” 
column. This will allow you to select the appropriate “Units”. 

 
FIGURE 28: PROJECT UNITS DIALOG 
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3. Select the Survey Point and click the paper clip until it has a red slash through it. This 
will unclip the Survey Point and allow it to stay in the same position relative to the Project 
Base Point. In our example this means that it obtain the same coordinates as the Project 
Base point.  

 
FIGURE 29: SURVEY POINT UNCLIPPED 

4. Isolate the Project Base Point in the view. As we already established, the Project Base 
Point is located at the building datum. The Civil Engineer provided the coordinate 
location information for this point in a text file. Isolating this element makes sure that we 
click this point in the next step and not another point on the building.  

a. With the Project Base Point selected, click the “Temporary Hide/Isolate” option 
and choose “Isolate Element”. 

 
FIGURE 30: TEMPORARY ISOLATE ELEMENT 
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5. On the “Manage” tab of the Ribbon, under “Coordinates” drop-down, click the tool named 
“Specify Coordinates at Point“. This tool allows you to specify the location of the picked point 
on the Shared Coordinate System, thus establishing a relationship between the Shared 
Coordination System and the Project Coordinate System. 
 
Now, it might be tempting to select the Project Base Point and enter the values straight into 
the parameter fields in the Properties Palette. DO NOT DO THIS! Doing this will move your 
Project Base Point away from the Initial Origin. Using the “Specify Coordinates at Point” tool 
allows you to specify the location of a point in the model relative to the Shared Coordinate 
System without moving the Project Base Point away from the Initial Origin.  

 
FIGURE 31: SPECIFY COORDINATES AT POINT 

6. Click the Project Base Point. This will open the “Specify Shared Coordinates” dialog 
shown below. In this dialog, enter the information provided by the Civil Engineer. The 
Grid Northing value goes into the “North/South” parameter, the Grid Easting value goes 
into the “East/West” parameter, the Elevation value goes into the “Elevation” parameter, 
and the angle from True North value goes into the “Angle from Project North to True 
North” parameter. After all those values are entered click “OK”. 

 
FIGURE 32: SPECIFY SHARED COORDINATES DIALOG 
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7. At this point, nothing looks like it has changed. However, it did adjust the Shared 
Coordinates system. In order to see this change, do the following steps. 

 
a. “Reset Temporary Hide / Isolate” of the view. This allows us to see that all 3 

reference points are still in the same place.  

 
FIGURE 33: RESET TEMPORARY HIDE/ISOLATE 

b. Open the EXPORT – CIVIL PLAN view we created above in the section “Export 
Civil Export Plan View”. Because the view property “Orientation” is set to True 
North for this view, (shown in Figure 10) we can see that the building is rotated. If 
we select the Project Base Point, we can see that the values for N/S, E/W, Elev, 
and Angle to True North have been entered. All the values should match the 
ones that you entered above except for Angle to True North. Don’t worry. It is 
actually at the correct angle, because we specified the difference between 
Project North and True North, which is what the Civil Engineer provided us. Revit 
did the calculations it needed in order to include the value it wants for the Angle 
to True North property. This is one more reason why you should not enter the 
values in these parameters.  

 
FIGURE 34: PROJECT BASE POINT WITH LOCATION 

8. Select the Survey Point. If you know the specific location (Grid Northing, Grid Easting, 
and Elevation values) of that point in the Shared Coordinate System (in our example 
VA83-S), then you can select the Survey Point and enter those values into the point’s 
properties. Because the point is unclipped, it will move around in the Shared Coordinate 
System. If you do not have a known location point that you want to mark, you can leave 
this point at the Project Base Point.  
 

9. Once the Survey Point is located, or left alone, click the paper clip to associate its 
relative location to the other reference points. 
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Link Civil Drawing and Align Coordinate Systems 
Now we have the coordinates of where our building is in the Civil Coordinate System, but our 
building still does not know which coordinate system that is. In our example, the coordinate 
system for Civil is set to VA83-SF. Without knowing this piece of information, our model does 
not know where it exists in the world. This is where linking the Civil 3D DWG file is important. By 
linking in the Civil 3D file, even if only temporarily, we can gather the coordinate system from the 
file and allow Revit to know the coordinate system, thus locating the building.  
 
Follow the steps below to gather the Coordinate System form the Civil 3D file 
 

1. Open the EXPORT – CIVIL PLAN floor plan view 
2. On the “Insert” Ribbon tab, on the “Link” Panel, choose “Link CAD” 

 
FIGURE 35: LINK CAD 

3. In the “Link CAD Formats” dialog, navigate and select the Civil 3D file saved by the Civil 
Engineer. Before clicking “Open”, we need to configure the import settings. The items 
below explain each setting as it relates to the workflow. Refer to Figure 36: CIVIL 3D 
Link Settings for key settings.  

 
FIGURE 36: CIVIL 3D LINK SETTINGS 

a. Colors: This is up to you, but we typically recommend “Preserve” 
b. Layers: This is also up to you, but we typically recommend “All”.  
c. Import units: “Auto-Detect” normally works well, except if the DWGs units are set 

to US. Survey Feet, then it will read the incorrect units. If the drawing is set to 
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US. Survey feet, as is the case in our example, you will need to specify the units 
as “Feet”.  (This may seem counterintuitive, but it works). 

d. Uncheck “Correct Lines that are slightly off Axis”.  
e. Positioning: Set this to “Auto - By Shared Coordinates”. This is critical! This is 

what allows Revit to acquire the coordinate system for the Civil 3D file. This 
function was added in Revit 2018.  

f. Place: Recommend placing at a Grade level as sometimes Civil Engineers draw 
planimetrics at a 0 elevation. However, coordinate with the Civil Engineer and 
DWG file for correct z-axis placement.  

g. Uncheck “Orient to View”. This is not needed.  
4. During the linking process, the dialog below will open. Click “Align” which will link the 

DWG’s world coordinate system (specified by the Civil Engineer) with the Shared 
Coordinate System in the Revit Model. In turn this will cause Revit to acquire the named 
coordinate system from the Civil file. 

 
FIGURE 37: LINK CAD ALIGN COORDINATES 

The Civil 3D DWG file should have been linked into the file with the correct x and y 
location. If the Civil Engineer left the building outline in the DWG file they sent, it should 
align with your building. The z-axis might be off because the link is associated with a 
level.  You can fix this as needed. 

5. From the “Manage” Ribbon tab, click on “Location”.  

 
FIGURE 38: LAUNCH LOCATION SETTINGS 
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6. Notice that the Revit file now lists the GIS Coordinate System Code, in our example 
VAS83-SF. It also displays the Latitude and Longitude of the specified point. As always, 
you can still specify to “Use Daylight Savings Time” for that location. This data was 
acquired from the Civil 3D file and was not possible prior to Revit 2018.  

 
FIGURE 39: REVIT LOCATION AND WEATHER W/ GIS 

7. The next time you save your Revit file, you will be prompted to save the “Current” 
Position to the linked DWG. Make sure to click “Disable Shared positioning” to prevent 
saving any coordinate changes back to the Civil 3D file.  

 
FIGURE 40: DISABLE SHARED POSITIONING 

8. At this time, even if you remove the link to the Civil 3D DWG, Revit will retain the GIS 
coordinate system. 
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If you need to reset the shared Coordinates of your model: 
 

• In Revit 2021.1, they added a new button on the “Manage” Ribbon tab under the 
“Coordinates” Panel.  

• In older versions, create a DWG with base AutoCAD and follow the steps for “Specify 
Coordinates at Point” and “Link Civil Drawing and Align Coordinate Systems” outlined 
above. Use 0,0,0,0 as the N/S, E/W, Elevation, and Angle values when specifying the 
point. This will reset your coordinate system back.  
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Step 5:  Synchronizing the Design Models [Civil 3D and Revit] 

Now that Revit knows the Shared Coordinate system, or in Civil terms - the Coordinate System, 
the fun can really begin. We can now start collaborating with other models and drawings in the 
same Coordinate System. This collaboration is not just limited to Revit and Civil 3D files! This 
collaboration can include any file that Revit can link, as well as other files such as Navisworks 
files that can be exported using shared coordinates.  
 
One of the first things we might want to collaborate on is the topography around the building. To 
accomplish this, it would be helpful to have the Civil Topography linked into the Revit model, as 
well as have a 3D building XREFed into the Civil 3D model. In order to accomplish this, we first 
need to have the Civil Engineer publish their Surface to a separate special DWG file. 
Additionally, we need the Architect to export the Revit model as an NWC file.  
 
As mentioned earlier, you will need to have either Navisworks Manage or the free Navisworks 
Export Utility installed in order to export to a Navisworks file from Revit. 
 
We are going to demonstrate and show linking Topography into Revit. Linking Topography in 
Revit is the most collaborative way of incorporating the Civil topography in Revit because it will 
update the same way as any other linked document. However, this does require the use of BIM 
360 Document Management. If you are unable to use BIM 360 Document Management, 
consider utilizing a LandXML export from Civil 3D and the free Site Designer add-in for Revit. 
This workflow was covered in the Autodesk University Course “A Match Made in Coordinates” 
which is available on the Autodesk University Website.  
 

Civil – Publish Surface 
In order to have Revit link the topography from a Civil file, we need to publish the Surface to a 
special DWG file. This function was added to Civil 3D 2019  

 

Follow these directions for publishing a Surface.  

 

1. On the “Collaborate” or “Output” tab of the Ribbon, go to the “Publish” panel and click 
“Publish Surfaces” 

 
FIGURE 41: PUBLISH SURFACE 

2. In the “Publish Surfaces” dialog, select the Surfaces you want to include in the publish. 
In our example we only had the Existing Ground to publish.  
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FIGURE 42: PUBLISH SURFACES DIALOG 

3. Use the browse button to open a “Save As” dialog. Navigate to the BIM 360 project 
shared folder and save the file to that location by clicking “OK”.  
 

4. If the “Surface Style Display” dialog appears, click “Publish the Surface with the updated 
style”.  

 
FIGURE 43: SURFACE STYLE DISPLAY 

 

That’s it! That’s all that is needed to be done to let the Architect link in the Civil Topography for 
coordination.  

 

Revit - Linking Civil Topography 
As of Revit 2019, you can link a topography Surface created by a Civil Engineer. It will work like 
any other link; you will be unable to edit it within your model and it can be reloaded after the file 
is updated. This makes coordinating with Civil topography a lot easier. The catch is that the 
linked topography file must live on BIM 360. If the file is not on BIM 360, you will be unable to 
link the file into Revit as the interface limits you to only selecting files on BIM 360. This is the 
only part of the workflow in the class that specifically requires the use of BIM 360.  
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The other advantage of bringing the Surface in as a separate link is that if the Civil Engineer is 
creating planimetrics at 0 elevation while the Surface is at the correct elevation, in Revit they 
can be co-located at the true elevation. 

 

Follow these steps to link in a Topography Surface.  

 

1. Create a Coordination View that shows Topography.  

a. Delete or rename your current default 3D view. If you are in a non-workshared 
model it will be named “{3D}” if you are in a workshared model, then the view 
name will start with “{3D -“ followed by your username and then a “}”.  

b. On the “View” Ribbon tab, on the “Create” Panel, Click “3D View”. This creates a 
new default 3D view. Refer to Figure 26 for more information. 

c. Rename this view COORDINATION – 3D 
d. Change the “Discipline” property of the view to “Coordination”. 
e. Change any view sorting parameters as needed to group with the rest of your 

coordination views.  
f. Open the “Visibility/Graphics” dialog box (type VV or VG on the keyboard, or 

refer to Figure 5) 
g. Check “Topography” under “Visibility”.  

 
2. On the “Insert” Ribbon tab, click “Link Topography”. 

 
FIGURE 44: LINK TOPOGRAPHY 

3. In the dialog that appears, navigate to your BIM 360 project and the folder where the 
Civil Engineer published the Surface dwg file. Select the file then click “Link”.  

 
FIGURE 45: LINK TOPOGRAPHY PROPERTIES 

Because the Shared Coordinate System was established and aligned to the Civil DWG 
Coordinate System, the Surface will come in at the correct location.  
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Revit - Create Navisworks Export View 
The Civil Engineer does not need the entire building to be inserted into their site. They only 
need the Exterior and Foundation Walls, as well as any exterior doors. In order to accomplish 
this, we are going to create a new 3D view that shows only these elements.  

 

Follow these steps to create a new EXPORT Civil 3D view. 

1. Delete or rename your current default 3D view. If you are in a non-workshared model it 
will be named “{3D}” if you are in a workshared model, then the view name will start with 
“{3D -“ followed by your username and then a “}”.  
 

2. On the “View” Ribbon tab, on the “Create” Panel, Click “3D View”. This creates a new 
default 3D view. Refer to Figure 26 for more information. 
 

3. Rename this view EXPORT – CIVIL 3D 
 

4. Change the “Discipline” property of the view to “Coordination”. 
 

5. Change any view sorting parameters as needed to group with the rest of your 
coordination views.  
 

6. Open the “Visibility/Graphics” dialog box (type VV or VG on the keyboard, or refer to 
Figure 5) 
 

7. Turn off all Categories that are not visible from the exterior. In our example, we left 
Curtain Panels, Curtain Systems., Curtain Wall Mullions, Doors, Floors, Roofs, Stairs, 
Structural Columns, Walls, and Window categories ON. For all other categories, visibility 
was unchecked.  
 

8. Go to the “Filters” Tab of the dialog. We want to write a filter that hides all walls that do 
not have a function of “Exterior” or “Foundation”. Click “Add” on this tab.  
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9. On the “Add Filter” dialog click “Edit/New” 

 
FIGURE 46: VISIBILITY / GRAPHICS - FILTERS EDIT / NEW 

10. In the Filters dialog, create a new filter named “Walls and Doors – Not Exterior or 
Foundation”.  
 

a. Under “Categories”, select “Walls and Doors”.  
 

b. Set the “Filter rules” to match Figure 47: Walls and Doors - Not Exterior or 
Foundation, below. 
 

c. Click “OK” 

 
FIGURE 47: WALLS AND DOORS - NOT EXTERIOR OR FOUNDATION 
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11. Back in the “Add Filters” dialog, select “Walls and Doors – Not Exterior or Foundation”. 

 
FIGURE 48: ADD WALLS AND DOORS - NOT EXTERIOR OR FOUNDATION 

12. Uncheck the Visibility of “Walls and Doors – Not Exterior or Foundation” filter. 

 
FIGURE 49: WALLS AND DOORS - NOT EXTERIOR OR FOUNDATION VISIBILITY OFF 
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13. Go to the “Imported Categories” tab and make sure the visibility of the Civil 3D DWG file 
is unchecked.  

 
FIGURE 50: IMPORT CATEGORIES CIVIL LINK OFF 

14. Click OK to close the “Visibility/Graphic Override” dialog.  
 

At this point the 3D view is configured for export to Civil 3D.  
 

Revit - Export to Navisworks. 
Civil 3D cannot XREF a native Revit file, so we must export the Revit model to another file 
format. We are going to export to a Navisworks NWC file because in addition to being a 3D 
DWG file, it is the only file format that can be exported with the Shared Coordinate System. 
Plus, NWC files are lighter and therefore easier to work with in 3D views in AutoCAD than a 3D 
AutoCAD model of the project.  

 

Follow these steps to export an NWC file from Revit.  

 

1. Open the EXPORT – CIVIL 3D view previously created. 
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2. Go to “File” ➔ “Export” ➔ “NWC” 

 
FIGURE 51: REVIT EXPORT TO NWC 

3. Browse to your BIM 360 project directory, select the folder that has been configured for 
sharing files with the Civil Engineers, and specify a name for your NWC file. Then click 
“Navisworks Settings”. 

 
FIGURE 52: NWC EXPORT NAVISWORKS SETTINGS 

  

NOTE: If you do not see NWC listed as an Export 
Option, check to see if you have Navisworks Manage 
or the NWC export utility installed. 
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4. Configure the Navisworks Export settings as shown below in Figure 53. 

 
FIGURE 53: NAVISWORKS SETTINGS 

5. Click “OK”, then click “Save” 

At this point, let your Civil Engineer know that the Navisworks file is available for their 
coordination. 

 

Civil – XREFing the Navisworks file 
Now that the Architect has configured the shared coordinate system of their model within Revit, 
it’s possible to incorporate a 3D representation of the model inside Civil 3D. The 3D 
Coordination Model provided by the Architect should insert at its precise location on the Civil 3D 
site. 

 
Follow these steps to insert a Navisworks NWC file of the building model into Civil 3D: 

NOTE: “Convert room as attributes” is only required if 
you want elements to identify room name and number 

TIP: Remember, Revit does not have an option for 
“US Survey Feet” during the export process. For this 
reason, the closest option they can choose when they 
export these files is “Feet”. If you are working in US 
Survey Feet in the Civil 3D Drawing, you will have to 
use Step 1 below to temporarily change your 
AutoCAD Drawing Insertion Units to “Feet” to prevent 
conversion. 
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1. (Not always applicable) - If your Civil 3D drawing is set to a coordinate system that uses 

US Survey Feet and the AutoCAD Units have also been changed to Survey Feet, you 
will need to make a temporary change before attaching the NWC file. You will want to 
temporarily change the drawing’s AutoCAD Insertion Units to “Feet” in the AutoCAD 
“Units” dialog.  Otherwise, Civil 3D will convert the model in the NWC file with the 
conversion factor from Feet to US Survey Feet, changing the size and placement of the 
model. Follow the steps below to accomplish this: 
 

a. Type UNITS in the command line and hit <Enter>. 
 

b. In the dialog that appears, change drop-down under “Insertion Scale” to match 
the unit type in the NWC file (Feet), and hit “OK” 

 
FIGURE 54: UNITS INSERTION SCALE 

2. On the “Insert” tab of the Ribbon, on the “Reference” Panel, click “Attach”.  

 
FIGURE 55: ATTACH FILE 
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3. In the “Select Reference File” dialog, choose “Navisworks Files (*.nwc, *.nwd)” from the 
“Files of Type” drop-down at the bottom. 

 
FIGURE 56: SELECT REFERENCE FILE - NWC 

4. Navigate to and select the NWC file exported by the Architect from Revit. Click “Open” to 
display the “Attach Coordination Model” dialog box as shown in Figure 57. 

5. Specify how to insert the Navisworks NWC file into your drawing by specifying the 
following: 

a. Path Type:  Relative Path 
b. Insertion Point:  X = 0, Y=0, Z=0 
c. Scale:    set to 1. 
d. Rotation:   Angle=0 

 
FIGURE 57: ATTACH COORDINATION MODEL SETTINGS 

e. Click “OK” 
Since the NWC export from Revit was configured with the same coordinate system as 
the Civil drawing, and we set the insertion units to match the NWC units, the building can 
be located using the default insertion values. 
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6. If you changed the AutoCAD Insertion Units to “Feet” in Step 1 above, change them 

back to “US Survey Feet”. 
 
The building is located at the correct elevation which should match the 3D Surface for 
coordination of the Surface modeling. If the elevation needs to be adjusted as the topography is 
updated, notify the Architect and they will need to adjust the point location by using the “Specify 
Coordinates at Point” tool again.  
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Step 6:  Visualize in Infraworks [CIVIL] 

While there are many tools for visualizing designs, few can efficiently include those designs in 
the context of their surroundings. The power of InfraWorks rests with its ability to visualize 
projects in the context of its surroundings.  
 
Even though the most recent versions of InfraWorks can import native RVT files, InfraWorks 
reads the Project Coordinate System of these files instead of the Shared Coordinate System, 
and therefore cannot locate the building without the user manually specifying the insertion point 
and angle. Additionally, just like with Civil 3D, the Revit file contains a lot of information in the 
interior of the building that is not required for InfraWorks. For this reason, we will use the FBX 
format to take our Revit model to InfraWorks. 
 

Generating a Geo-Reference FBX File from the Revit Model 
The FBX format is intended to provide a simple way to exchange 3D model data between 
different software applications. Today, nearly every Autodesk application with 3D features is 
capable of both reading and writing FBX files. 
 
While Revit can export FBX files, it does not include the export options necessary to specify the 
coordinate system of the FBX file. For this reason, we will utilize the Navisworks file that the 
Architect already created. Using Navisworks we will create an FBX file that includes the correct 
coordinate system. We will then import this file into InfraWorks.  
 
Follow these steps to create an FBX file in the coordinate system.  
 

1. In Navisworks, create a new file.  
2. In the “Home” tab of the Ribbon, on the “Project” tab, click “Append”.  

 
FIGURE 58: NAVISWORKS APPEND 
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3. In the dialog that appears, change the “Files of Type” to “Navisworks Cache (NWC)” and 
navigate to the file the Architect exported from Revit. Once the file is selected, click 
“Open”. 

 
FIGURE 59: APPEND OPEN 

At this point the building should be visible in the Navisworks Model as shown below.  
 

 
FIGURE 60: NAVISWORK MODEL 
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4. From the Navisworks “Application Menu”, choose “Export” ➔ “FBX”. 

 
FIGURE 61: NAVISWORKS EXPORT FBX 

 
5. In the “FBX Options” dialog, set the “Convert Units To” the units matching the InfraWorks 

file you already have created; in our case it will be “Feet”. Click “OK” to open the “Export” 
dialog. 

 
FIGURE 62: FBX OPTIONS 

 
6. Navigate to the appropriate folder and provide a name for your FBX file from the “Export” 

dialog, then click “Save”. 
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Import a FBX File into InfraWorks 
Once an FBX file is created with the correct coordinate system, it can be incorporated into our 
final InfraWorks model. To ensure our building model is placed in the correct location, it’s 
important to know what coordinate system the Civil 3D and Revit projects were configured for.  
In our example, the Civil 3D and Revit projects were configured to use the NAD 83 Virginia 
State Planes, South Zone, US Foot (VA83-SF) coordinate system. 
 
Follow these steps to import the geo-referenced FBX into InfraWorks: 
 

1. In Infraworks, open the desired model 
2. If the “Data Sources” panel is not already open, go the “Manage” tab of the Ribbon, and 

on the “Content” Panel, click “Data Sources” as shown below. 

 
FIGURE 63: INFRAWORKS DATA SOURCES 

3. In the “Data Sources panel, click the small triangle to expand the “Add File Data Source” 
menu. Then click “3D Model” as shown below.  

 
FIGURE 64: DATA SOURCES PANEL - ADD SOURCE 
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4. Use the “Select Files” dialog to browse to the previously created FBX file. The FBX file is 
added to the Data Sources tree with the classification “<No Feature Type>”. 

 
FIGURE 65: NO FEATURE TYPE 

5. Select the FBX file listed in the “Data Sources” panel and click “Configure” as shown in 
Figure 66.  

 
FIGURE 66: CONFIGURE DATA SOURCE 
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6. In the “Configure” dialog, there are a few settings that need to be made.  
a. Set the “Type” to “Buildings”. 
b. Set the “Coordinate System” to match the coordinate system of the Civil 3D and 

Revit file. In our example it will be “VA83-SF”.  
c. The “Position” section will gray out, which is correct.  
d. Leave the “Scale” factors at 1.  
e. Leave the “Offset and Rotation” values at 0. Because the building is in the correct 

Coordinate System, this information with be gathered form the file.  
f. Click “Close and Refresh”. 

 
FIGURE 67: FBX SOURCE CONFIGURATION 

7. InfraWorks processes the FBX file and places it into the model. As mentioned, because 
the FBX file was in the correct coordinate system, it was placed in the InfraWorks model 
at the correct location and with the correct rotation.  
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Congratulations! You have now created a visual representation of the building and the 
surrounding site.  
 

 
FIGURE 68: BUILDING IN INFRAWORKS 
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BONUS 

Now that the Revit file is coordinate with a real-world coordinate system it can easily be 
coordinated with other documents in the same coordinate system. One example would be point 
cloud scans during construction. Another example would be locating adjacent buildings and 
structures on the same campus. 
 
Property Managers will love you. Contractors will like you, (they will really love you, but they 
would never say that). But most importantly Civil and Architects will be Allies at last!  
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